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Important Information

Warranty

The IMAQ PCI-1408 is warranted against defects in materials and workmanship for a period of one year from the date 
of shipment, as evidenced by receipts or other documentation.  National Instruments will, at its option, repair or replace 
equipment that proves to be defective during the warranty period.  This warranty includes parts and labor.  

The media on which you receive National Instruments software are warranted not to fail to execute programming 
instructions, due to defects in materials and workmanship, for a period of 90 days from date of shipment, as evidenced 
by receipts or other documentation.  National Instruments will, at its option, repair or replace software media that do 
not execute programming instructions if National Instruments receives notice of such defects during the warranty 
period.  National Instruments does not warrant that the operation of the software shall be uninterrupted or error free.

A Return Material Authorization (RMA) number must be obtained from the factory and clearly marked on the outside 
of the package before any equipment will be accepted for warranty work.  National Instruments will pay the shipping 
costs of returning to the owner parts which are covered by warranty.

National Instruments believes that the information in this manual is accurate.  The document has been carefully 
reviewed for technical accuracy.  In the event that technical or typographical errors exist, National Instruments reserves 
the right to make changes to subsequent editions of this document without prior notice to holders of this edition.  The 
reader should consult National Instruments if errors are suspected.  In no event shall National Instruments be liable for 
any damages arising out of or related to this document or the information contained in it.

EXCEPT AS SPECIFIED HEREIN, NATIONAL INSTRUMENTS MAKES NO WARRANTIES, EXPRESS OR IMPLIED, AND 
SPECIFICALLY DISCLAIMS ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.  
CUSTOMER’S RIGHT TO RECOVER DAMAGES CAUSED BY FAULT OR NEGLIGENCE ON THE PART OF NATIONAL 
INSTRUMENTS SHALL BE LIMITED TO THE AMOUNT THERETOFORE PAID BY THE CUSTOMER.  NATIONAL INSTRUMENTS 
WILL NOT BE LIABLE FOR DAMAGES RESULTING FROM LOSS OF DATA, PROFITS, USE OF PRODUCTS, OR INCIDENTAL OR 
CONSEQUENTIAL DAMAGES, EVEN IF ADVISED OF THE POSSIBILITY THEREOF.  This limitation of the liability of National 
Instruments will apply regardless of the form of action, whether in contract or tort, including negligence.  Any action 
against National Instruments must be brought within one year after the cause of action accrues.  National Instruments 
shall not be liable for any delay in performance due to causes beyond its reasonable control.  The warranty provided 
herein does not cover damages, defects, malfunctions, or service failures caused by owner’s failure to follow the 
National Instruments installation, operation, or maintenance instructions; owner’s modification of the product; 
owner’s abuse, misuse, or negligent acts; and power failure or surges, fire, flood, accident, actions of third parties, or 
other events outside reasonable control.

Copyright

Under the copyright laws, this publication may not be reproduced or transmitted in any form, electronic or mechanical, 
including photocopying, recording, storing in an information retrieval system, or translating, in whole or in part, 
without the prior written consent of National Instruments Corporation.

Trademarks

LabVIEW®, RTSI®, CVI™, IMAQ™, and MITE™ are trademarks of National Instruments Corporation.

Product and company names listed are trademarks or trade names of their respective companies.

WARNING REGARDING MEDICAL AND CLINICAL USE OF NATIONAL INSTRUMENTS PRODUCTS

National Instruments products are not designed with components and testing intended to ensure a level of reliability 
suitable for use in treatment and diagnosis of humans.  Applications of National Instruments products involving 
medical or clinical treatment can create a potential for accidental injury caused by product failure, or by errors on the 
part of the user or application designer.  Any use or application of National Instruments products for or involving 
medical or clinical treatment must be performed by properly trained and qualified medical personnel, and all traditional 
medical safeguards, equipment, and procedures that are appropriate in the particular situation to prevent serious injury 
or death should always continue to be used when National Instruments products are being used.  National Instruments 
products are NOT intended to be a substitute for any form of established process, procedure, or equipment used to 
monitor or safeguard human health and safety in medical or clinical treatment.



 
  FCC/DOC Radio Frequency Interference 

Class A Compliance

This equipment generates and uses radio frequency energy and, if not installed and used in strict 
accordance with the instructions in this manual, may cause interference to radio and television 
reception. Classification requirements are the same for the Federal Communications Commission 
(FCC) and the Canadian Department of Communications (DOC). This equipment has been tested and 
found to comply with the following two regulatory agencies:

Federal Communications Commission
This equipment has been tested and found to comply with the limits for a Class A digital device, 
pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against 
harmful interference when the equipment is operated in a commercial environment. This equipment 
generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with 
the instruction manual, may cause harmful interference to radio communications. Operation of this 
equipment in a residential area is likely to cause harmful interference in which case the user will be 
required to correct the interference at his own expense.

Notices to User: Changes or modifications not expressly approved by National Instruments could void 
the user’s authority to operate the equipment under the FCC Rules.

This device complies with the FCC rules only if used with shielded interface cables of 
suitable quality and construction. National Instruments used such cables to test this 
device and provides them for sale to the user. The use of inferior or nonshielded 
interface cables could void the user’s authority to operate the equipment under the 
FCC rules.

If necessary, consult National Instruments or an experienced radio/television technician for additional 
suggestions. The following booklet prepared by the FCC may also be helpful: Interference to Home 
Electronic Entertainment Equipment Handbook. This booklet is available from the U.S. Government 
Printing Office, Washington, DC 20402.

Canadian Department of Communications
This Class A digital apparatus meets all requirements of the Canadian Interference-Causing Equipment 
Regulations.

Cet appareil numérique de la classe A respecte toutes les exigences du Règlement sur le matériel 
brouilleur du Canada.
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About

This

Manual

Getting Started with Your IMAQ PCI-1408 and the NI-IMAQ Software 

for Windows 95/NT describes the features, functions, and operation of 

the PCI-1408. The PCI-1408 is a high-accuracy, monochrome PCI 

image acquisition (IMAQ) board that supports RS-170, CCIR, NTSC, 

and PAL video standards from any of four inputs. Getting Started with 

Your IMAQ PCI-1408 and the NI-IMAQ Software for Windows 95/NT 

is intended for users with a basic knowledge of image acquisition.

Organization of This Manual

Getting Started with Your IMAQ PCI-1408 and the NI-IMAQ Software 

for Windows 95/NT is organized as follows:

• Chapter 1, Introduction, describes the PCI-1408; lists what you 

need to get started; describes software programming choices, 

optional equipment, and custom cables; and explains how to 

unpack and set up the PCI-1408.

• Chapter 2, Configuration and Installation, explains how to 

configure and install your PCI-1408 board.

• Chapter 3, Hardware Overview, presents an overview of the 

hardware functions on your PCI-1408 board and explains the 

operation of each functional unit making up the PCI-1408.

• Chapter 4, Signal Connections, describes cable connections for the 

PCI-1408.

• Chapter 5, Configuration Utility, describes the basic functions of 

IMAQconf, the configuration and diagnostic utility included with 

the PCI-1408.

• Appendix A, Specifications, lists the specifications of the 

PCI-1408.

• Appendix B, Custom Cables, lists specifications for building 

custom cabling for your PCI-1408.

• Appendix C, Customer Communication, contains forms you can 

use to request help from National Instruments or to comment on our 

products and manuals.
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• The Glossary contains an alphabetical list and description of terms 

used in this manual, including abbreviations, acronyms, metric 

prefixes, mnemonics, and symbols.

• The Index contains an alphabetical list of key terms and topics in 

this manual, including the page where you can find each one.

Conventions Used in This Manual

The following conventions are used in this manual:

<> Angle brackets containing numbers separated by an ellipses represent a 

range of values associated with a bit or signal name (for example, 

ACH<0..7>).

– A hyphen between two or more key names enclosed in angle brackets 

denotes that you should simultaneously press the named keys—for 

example, <Control–Alt–Delete>.

» The » symbol leads you through nested menu items and dialog box 

options to a final action. The sequence 

File»Page Setup»Options»Substitute Fonts

directs you to pull down the File menu, select the Page Setup item, 

select Options, and finally select the Substitute Fonts options from the 

last dialog box.

bold Bold text denotes menus, menu items, or dialog box buttons or options.

italic Italic text denotes emphasis, a cross reference, or an introduction to a 

key concept. This font also denotes text for which you supply the 

appropriate word or value, such as in Windows 3.x.

bold italic Bold italic text denotes a note, caution, or warning.

monospace Lowercase text in this font denotes text or characters that are to be 

literally input from the keyboard, sections of code, programming 

examples, and syntax examples. This font is also used for the proper 

names of disk drives, paths, directories, programs, subprograms, 

subroutines, device names, functions, variables, filenames and 

extensions, and for statements and comments taken from programs.

Abbreviations, acronyms, metric prefixes, mnemonics, symbols, and 

terms are listed in the Glossary.
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National Instruments Documentation

Getting Started with Your IMAQ PCI-1408 and the NI-IMAQ Software 

for Windows 95/NT is one piece of the documentation set for your image 

acquisition system. You could have any of several types of manuals, 

depending on the hardware and software in your system. Use the 

different types of manuals you have as follows:

• Software documentation—You may have both application software 

and NI-IMAQ software documentation. National Instruments 

application software includes LabVIEW and LabWindows®/CVI. 

After you set up your hardware system, use either the application 

software (LabVIEW or LabWindows/CVI) documentation, or the 

NI-IMAQ documentation to help you write your application. If you 

have a large and complicated system, it is worthwhile to look 

through the software documentation before you configure your 

hardware.

• Accessory installation guides or manuals—If you are using 

accessory products, read the terminal block and cable assembly 

installation guides or accessory board user manuals. They explain 

how to physically connect the relevant pieces of the system. 

Consult these guides when you are making your connections.

Related Documentation

The following documents contain information that you may find helpful 

as you read this manual:

• Your computer technical reference manual

Customer Communication

National Instruments wants to receive your comments on our products 

and manuals. We are interested in the applications you develop with our 

products, and we want to help if you have problems with them. To make 

it easy for you to contact us, this manual contains comment and 

configuration forms for you to complete. These forms are in 

Appendix C, Customer Communication, at the end of this manual.
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Chapter

1Introduction

This chapter describes the PCI-1408; lists what you need to get started; 

describes software programming choices, optional equipment, and 

custom cables; and explains how to unpack and set up the PCI-1408.

About the PCI-1408

The PCI-1408 is a high-accuracy, monochrome, PCI-based IMAQ 

board that supports RS-170, CCIR, NTSC, and PAL video standards 

from any of four input sources. The board features an 8-bit flash analog-

to-digital converter (ADC) that converts video signals to digital 

formats. The PCI-1408 acquires frames in real time and transfers them 

directly to system memory.

The PCI-1408 is simple to configure and is factory calibrated so that 

you can easily install the board and begin your image acquisition. The 

PCI-1408 ships with NI-IMAQ, the National Instruments complete 

IMAQ driver software you can use to directly control the PCI-1408. 

Using NI-IMAQ, you can quickly and easily start your application 

without having to program the board at the register level.

Featuring low cost and high accuracy, the PCI-1408 is ideal for both 

industrial and scientific environments. As a standalone board, the 

PCI-1408 supports four video sources and four external I/O lines that 

you can use as triggers or digital I/O lines. If you require more advanced 

triggering or additional I/O lines (either digital or analog), you can use 

the PCI-1408 and NI-IMAQ with the National Instruments data 

acquisition (DAQ) product line.

A common problem with IMAQ boards is that you cannot easily 

synchronize several functions to a common trigger or timing event. The 

PCI-1408 uses its Real-Time System Integration (RTSI) bus to solve 

this problem. The RTSIbus consists of the National Instruments 

RTSIbus interface and ribbon cable to route additional 
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timing and trigger signals between the PCI-1408 and up to four National 

Instruments DAQ boards in your computer. The RTSI bus can even 

synchronize multiple PCI-1408 image captures.

Detailed specifications of the PCI-1408 are in Appendix A, 

Specifications.

What You Need to Get Started

To set up and use your PCI-1408, you will need the following:

❑ PCI-1408

❑ NI-IMAQ for Windows 95/NT Release Notes

❑ Getting Started with Your IMAQ PCI-1408 and the NI-IMAQ 

Software for Windows 95/NT

❑ NI-IMAQ for Windows 95/NT and online documentation

❑ Optional software packages and documentation:

– LabVIEW

– LabWindows/CVI

– IMAQ Vision for LabVIEW

– IMAQ Vision for LabWindows/CVI

❑ IMAQ BNC-1 shielded, 75 Ω BNC cable for VIDEO0 (included with 

the PCI-1408)

❑ IMAQ A2504-1 video cable (optional—for trigger and additional 

camera support)

❑ IMAQ A2514-1 video cable (optional—for complete trigger, 

additional camera, and external synchronization support)

❑ BNC-to-RCA adapter (included with the PCI-1408)

❑ Your Pentium-based PCI computer running Windows 95 or 

Windows NT

❑ A video camera or other video source
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Software Programming Choices

You have several options to choose from when programming your 

National Instruments IMAQ hardware. You can use National 

Instruments application software such as LabVIEW and 

LabWindows/CVI, National Instruments image analysis software such 

as IMAQ Vision, or the NI-IMAQ driver software.

National Instruments Application Software
LabVIEW features interactive graphics, a state-of-the-art user 

interface, and a powerful graphical programming language. The 

LabVIEW IMAQ VI Library, a series of virtual instruments (VIs) for 

using LabVIEW with the PCI-1408, is included with the NI-IMAQ 

software kit. The LabVIEW IMAQ VI Library is functionally 

equivalent to the NI-IMAQ software.

LabWindows/CVI features interactive graphics, a state-of-the-art user 

interface, and uses the ANSI standard C programming language. The 

LabWindows/CVI IMAQ Library, a series of functions for using 

LabWindows/CVI with the PCI-1408, is included with the NI-IMAQ 

software kit. The LabWindows/CVI IMAQ VI Library is functionally 

equivalent to the NI-IMAQ software.

IMAQ Vision for LabVIEW is an image acquisition, processing, and 

analysis library that consists of more than 400 VIs for using the 

PCI-1408 with LabVIEW. You can use IMAQ Vision for LabVIEW 

functions directly or in combination for unique image processing. There 

are two versions of IMAQ Vision for LabVIEW. The Base version gives 

you the ability to acquire, display, manipulate, and store images. The 

Advanced version is a complete set of functions for image analysis, 

processing, and interpretation. Using IMAQ Vision for LabVIEW, an 

imaging novice or expert can perform graphical programming of the 

most basic or complicated image applications without knowledge of 

any algorithm implementations.

IMAQ Vision for LabWindows/CVI is an image acquisition and 

analysis library consisting of a series of routines for using the PCI-1408 

with LabWindows/CVI. IMAQ Vision for LabWindows/CVI brings the 

same functionality to LabWindows/CVI as IMAQ Vision for LabVIEW 

does for LabVIEW.
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NI-IMAQ Driver Software
The NI-IMAQ driver software is included at no charge with the 

PCI-1408. NI-IMAQ has an extensive library of functions that you can 

call from your application programming environment. These functions 

include routines for video configuration, image acquisition (continuous 

and single-shot), memory buffer allocation, trigger control, and board 

configuration. The NI-IMAQ driver software performs all functions 

required for acquiring and saving images. The NI-IMAQ software does 

not perform any image analysis. For image analysis functionality, refer 

to the National Instruments Application Software section earlier in this 

chapter.

NI-IMAQ has both high-level and low-level functions for maximum 

flexibility and performance. Examples of high-level functions include 

the functions to acquire images in single-shot or continuous mode. An 

example of a low-level function is configuring an image sequence since 

it requires advanced understanding of the PCI-1408 and image 

acquisition.

NI-IMAQ also internally resolves many of the complex issues between 

the computer and the PCI-1408, such as programming interrupts and 

DMA controllers. NI-IMAQ is the interface path between LabVIEW, 

LabWindows/CVI, or a conventional programming environment and 

the PCI-1408.

Any platform that supports NI-IMAQ also supports NI-DAQ and a 

variety of National Instruments DAQ boards, so your PCI-1408 and 

NI-IMAQ development can integrate with National Instruments DAQ 

products.

Whether you are using conventional programming languages or 

National Instruments software, your application uses the NI-IMAQ 

driver software, as illustrated in Figure 1-1.
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Figure 1-1.  The Relationship between the Programming Environment, 

NI-IMAQ, and Your Hardware

Optional Equipment

National Instruments offers a variety of products for use with your 

PCI-1408 board, including cables and other National Instruments 

products:

• A four-pod BNC cable, which routes video and trigger signals to a 

BNC connector block (IMAQ A2504-1)

• A 14-pod BNC cable, which routes all video, trigger, and 

synchronization signals to a BNC connector block 

(IMAQ A2514-1)

LabWindows/CVI

(Windows 95, NT)

LabVIEW 

(Windows 95, NT)

Conventional Programming

Environment (PC)

DAQ Hardware
NI-IMAQ


Driver Software

IMAQ Hardware
Personal 


Computer or 

Workstation
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• RTSIbus cables, for connecting the PCI-1408 to other DAQ 

hardware

• Other National Instruments DAQ devices for enhanced triggering, 

timing, or input/output

For more specific information about these products, refer to your 

National Instruments catalogue or call the office nearest you.

Unpacking

Your PCI-1408 board is shipped in an antistatic package to prevent 

electrostatic damage to the board. Electrostatic discharge can damage 

several components on the board. To avoid such damage in handling the 

board, take the following precautions:

• Ground yourself via a grounding strap or by holding a grounded 

object.

• Touch the antistatic package to a metal part of your computer 

chassis before removing the board from the package.

• Remove the board from the package and inspect the board for loose 

components or any other signs of damage. Notify National 

Instruments if the board appears damaged in any way. Do NOT 

install a damaged board in your computer.

• Never touch the exposed pins of connectors.

How to Set up Your IMAQ System

Use Figure 1-2 to install your hardware and software, configure your 

hardware, and begin using NI-IMAQ in your application programs.

If you will be accessing the NI-IMAQ device drivers through LabVIEW 

or LabWindows/CVI, you should read the NI-IMAQ release notes and 

Note to Users, Using Application Software with Your IMAQ Hardware, 

to help you get started.
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Figure 1-2.  How to Set up Your IMAQ System

No YesAre you using 


application software?

Read Chapter 2, Fundamentals of 

Building Windows Applications with NI-IMAQ, in the 


NI-IMAQ User Manual.




Read the sections in Chapter 3, Software Overview, 


and Chapter 4, Programming with NI-IMAQ, 

in the NI-IMAQ User Manual that apply to the NI-IMAQ 


function groups you will use in your application.

Continue by reading :

Configure your hardware using the NI-IMAQ 


configuration utility, IMAQconf, as described


 in Chapter 5, Configuration Utility, in 


this document.

Look at the self-documented example source 


code on your distribution diskettes for your 


application language and environment.

Use the NI-IMAQ Function Reference Manual 

when you need specific information about 


individual NI-IMAQ functions.




Read the NI-IMAQ release notes and follow the


instructions to install your NI-IMAQ software and 


documentation.

Follow the hardware installation instructions in 


Chapter 2, Configuration and Installation, 


in this document.




•  Note to Users, Using Application Software

   with Your IMAQ Hardware, if you are using 


   LabVIEW or LabWindows/CVI


•  Your IMAQ Vision for LabVIEW


   documentation if you are using IMAQ 


   Vision for LabVIEW


•  Your IMAQ Vision for LabWindows/CVI


   documentation if you are using IMAQ 


   Vision for LabWindows/CVI


You no longer need the NI-IMAQ manual set.
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Chapter

2Configuration and 
Installation

This chapter explains how to configure and install your PCI-1408 

board.

Board Configuration

This section describes how to configure the following options on the 

PCI-1408 board:

• VIDEO0 input mode

• External CLK and synchronization input mode

All other configuration options are software configurable.

Figure 2-1 shows the location of user-configurable jumpers and 

switches as well as factory-default settings on the PCI-1408.
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Figure 2-1.  Parts Locator Diagram

VIDEO0 Input Mode
VIDEO0 has two different input sources via a BNC connector or a 

25-pin DSUB port and two different input modes—referenced single-

ended (RSE) and differential (DIFF) input. When you use the BNC 

input for VIDEO0, set the input mode to RSE (W1 populated). When 

you use the 25-pin DSUB port for VIDEO0, set the input mode for 

either RSE or DIFF.

When in RSE mode, the video input uses one analog input line, which 

connects to the video multiplexer circuitry. The negative input to the 

video multiplexer is tied internally to analog ground. When in DIFF 

mode, the video input uses two analog input signals. One signal 

connects to the positive input of the video multiplexer circuitry while 

the other input signal connects to the negative input of the video 

multiplexer circuitry. Jumper W1 controls the input mode selection, as 
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shown in Figure 2-2. Unpopulating W1 configures VIDEO0 for DIFF 

mode. Populating W1 configures VIDEO0 for RSE mode.

Figure 2-2.  Configuring VIDEO0 with Jumper W1

External CLK and Synchronization Input Mode
The external PCLK, VSYNC, HSYNC, and CSYNC signals have two 

different input modes—RSE (TTL) and DIFF (RS-422) input. With 

RSE, the input uses one analog input line, which connects to the 

synchronization selection circuitry. The negative input to the 

synchronization selection circuitry is tied internally to analog ground. 

For RSE mode, populate all five sets of jumpers on W3, as shown in 

Figure 2-3. With DIFF mode, the input uses two analog input signals. 

One signal connects to the positive input of the synchronization 

selection circuitry while the other input connects to the negative input 

of the synchronization selection circuitry.

Figure 2-3.  Configuring PCLK, VSYNC, HSYNC, and CSYNC with Jumper W3

a. RSE Mode (Default) b. DIFF Mode

a. RSE Mode (Default) b. DIFF Mode
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Switch S1
Switch S1 is unused and should always be in the ON position, as shown 

in Figure 2-4. 

Figure 2-4.  Switch S1

Installation

Note: You must install the NI-IMAQ driver software before installing your 

IMAQ hardware. For information on how to install NI-IMAQ, please see 

your NI-IMAQ release notes.

You can install the PCI-1408 board in any available PCI expansion slot 

in your PC. However, to achieve the best noise performance, you should 

leave as much room as possible between the PCI-1408 board and other 

boards and hardware. The following are general instructions, but 

consult your computer user manual or technical reference manual for 

specific instructions and warnings.

1. Plug in but do not turn on your computer before installing the 

PCI-1408. The power cord grounds the computer and protects it 

from electrical damage while you are installing the module.

Warning: To protect both yourself and the computer from electrical hazards, the 

computer should remain off until you finish installing the PCI-1408 

module.

2. Remove the top cover or access port to the PCI bus.

3. Select any available PCI expansion slot.
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4. Locate the metal bracket that covers the cut-out in the back panel 

of the chassis for the slot you have selected. Remove and save the 

bracket-retaining screw and the bracket cover. 

5. Touch the metal part of the power supply case inside the computer 

to discharge any static electricity that might be on your clothes or 

body.

6. Line up the PCI-1408 with the 25-pin DSUB and BNC connectors 

near the cut-out on the back panel. Slowly push down on the top of 

the PCI-1408 until its card-edge connector is resting on the 

expansion slot receptacle. Using slow, evenly distributed pressure, 

press the PCI-1408 straight down until it seats in the expansion slot.

7. Reinstall the bracket-retaining screw to secure the PCI-1408 to the 

back panel rail.

8. Check the installation.

9. Replace the computer cover.

Your PCI-1408 is now installed.
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Chapter

3Hardware Overview

This chapter presents an overview of the hardware functions on your 

PCI-1408 board and explains the operation of each functional unit 

making up the PCI-1408.

Functional Overview

The PCI-1408 features an 8-bit flash ADC that converts video signals 

to digital formats, four video signal multiplexers, and programmable 

gain and offset. It also uses a PCI interface for high-speed data transfer, 

scatter-gather DMA controllers that control the transfer of data between 

the first-in, first-out (FIFO) memory buffers and the PCI bus, 

nonvolatile and static RAM for configuring registers on power-up and 

programming the DMA controllers, and acquisition and 

region-of-interest control circuitry that monitors video signals. The 

board also includes powerful trigger circuitry including four external 

triggers and RTSIbus triggers. Other features include internally 

generated or externally input CSYNC, HSYNC, VSYNC, and PCLK 

synchronization and clock signals.

The block diagram in Figure 3-1 illustrates the key functional 

components of the PCI-1408.
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Figure 3-1.  PCI-1408 Block Diagram

Video Mux
You can select of any of the four AC-coupled video inputs through the 

video multiplexer circuitry.

Antichrominance Filter
The PCI-1408 includes an antichrominance filter that removes 

chrominance from a composite color video signal. You can use two 

software-selectable antichrominance filters: a 3.58 MHz notch filter to 

remove color information from an NTSC signal and a 4.43 MHz notch 

filter to remove color information from a PAL signal.

Programmable Gain and Offset

The PCI-1408 uses programmable gain and offset circuitry to optimize 

the input signal range.
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8-Bit ADC and LUT

An 8-bit flash ADC digitizes the image, which is passed to a 

256-by-8 bit lookup table (LUT) RAM. You can configure the input 

LUT to implement simple imaging operations such as contrast 

enhancement, data inversion, gamma manipulation, or other nonlinear 

transfer functions.

CSYNC Mux
The composite synchronization (CSYNC) multiplexer lets the genlock 

and synchronization circuitry select the internally generated composite 

synchronization signal or the composite synchronization signal 

received from the I/O connector.

Genlock and Synchronization Circuitry
The genlock and synchronization circuitry receives the incoming video 

signal and generates a PCLK, HSYNC, and VSYNC signal for use by 

the acquisition and control circuitry. The synchronization circuitry 

interacts with the voltage-controlled oscillator (VCO) and phase-locked 

loop (PLL) circuitry, which generates and controls the PCLK.

VCO and PLL Circuitry

The VCO and PLL circuitry controls the internally generated PCLK 

signal frequency. The PCI-1408 can digitize an incoming video signal 

at rates of up to 16.4 MHz.

Pixel Aspect Ratio Circuitry
The pixel aspect ratio circuitry adjusts the ratio between the physical 

horizontal size and the vertical size of the region covered by the pixel. 

This value is used to figure the picture aspect ratio. For more 

information, see the Acquisition Window Control section later in this 

chapter.
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PCLK, HSYNC, VSYNC Mux
The acquisition control circuitry selects the clock and synchronization 

signals through the pixel clock (PCLK), horizontal synchronization 

(HSYNC), and vertical synchronization (VSYNC) multiplexer. The 

onboard genlock and synchronization circuitry can generate clock and 

synchronization signals or the signals can be received from the I/O 

connector.

RTSIbus
The seven trigger lines on the RTSIbus provide a flexible 

interconnection scheme between multiple PCI-1408 boards as well as 

between any National Instruments DAQ devices and the PCI-1408.

Trigger Control and Mapping Circuitry
The trigger control and mapping circuitry routes, monitors, and drives 

the external and RTSIbus trigger lines. You can configure each of these 

lines to start or stop acquisition on a rising or falling edge. In addition, 

you can drive each line asserted or unasserted, similar to a digital I/O 

line. You can also map onboard status values (HSYNC, VSYNC, 

ACQUISITION_IN_PROGRESS, and ACQUISITION_DONE) to the 

lines.

Acquisition and Region-of-Interest Control

The acquisition and region-of-interest control circuitry monitors the 

incoming video signal and routes the active pixels to the FIFO buffers. 

The PCI-1408 can digitize an entire frame and perform pixel and line 

scaling and region-of-interest acquisition. Pixel and line scaling lets 

certain multiples (2, 4, or 8) of pixels and lines to be transferred to the 

PCI bus. In region-of-interest acquisition, you select an area in the 

acquisition window to transfer to the PCI bus.

FIFO Buffer

The PCI-1408 uses a 4 KB FIFO buffer for temporary storage of the 

image being transferred to the PCI system memory or display memory. 

The buffer stores six full video lines during image acquisition.
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Scatter-Gather DMA Controllers

The PCI-IMAQ-1408 uses three independent onboard direct memory 

access (DMA) controllers. The DMA controllers transfer data between 

the onboard first-in first-out (FIFO) memory buffers and the PCI bus. 

Each of these controllers supports scatter-gather DMA, which allows 

the DMA controller to reconfigure on-the-fly. Thus, the PCI-1408 can 

perform continuous image transfers to either contiguous or fragmented 

memory buffers.

SRAM

The PCI-1408 uses 64 KB of static RAM (SRAM) for programming the 

scatter-gather DMA controllers.

PCI Interface
The PCI-1408 implements the PCI interface with a National 

Instruments custom application-specific integrated circuit (ASIC), the 

miniMITE. The PCI interface can transfer data at a maximum rate of 

132 Mbytes/s in master mode, which maximizes the available PCI 

bandwidth. PCI-1408 can generate 8-, 16-, and 32-bit memory read and 

write cycles, both single and multiple. In slave mode, the PCI-1408 is a 

medium speed decoder that accepts both memory and configuration 

cycles. The interface logic ensures that the PCI-1408 meets the loading, 

driving, and timing requirements of the PCI specification.

Board Configuration NVRAM

The PCI-1408 contains onboard nonvolatile RAM (NVRAM) that 

configures all registers on power-up.
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Video Acquisition 

The PCI-1408 can acquire video signals in a variety of modes and 

transfer the digitized fields or frames to PCI system memory.

Start/Stop Conditions
The PCI-1408 can start and stop acquisition on a variety of conditions:

• Software control—The PCI-1408 supports software control of 

acquisition start and stop. In addition, you can configure the 

PCI-1408 to capture a fixed number of frames. This configuration 

is useful for capturing single frames or a sequence of frames.

• Trigger control—You can also start and stop acquisition by 

enabling external or RTSIbus trigger lines. Each of these 11 inputs 

can start or stop video acquisition on a rising or falling edge. You 

can use all four external triggers and up to two RTSIbus triggers 

simultaneously. 

• Delayed acquisition—You can use either software or triggers to 

start and stop acquisitions instantaneously or after capturing a 

desired number of frames or fields. This feature is useful for post- 

or pre-trigger applications.

• Frame/field selection—With an interlaced camera and the 

PCI-1408 in frame mode, you can program the PCI-1408 to start or 

stop acquisition on any odd field or any even field.

Acquisition Window Control
You can configure numerous parameters on the PCI-1408 to control the 

video acquisition window. A brief description of each parameter 

follows:

• Horizontal sync—HSYNC is the synchronization pulse signal 

produced at the beginning of each video scan line that keeps a video 

monitor’s horizontal scan rate in sequence with the transmission of 

each new line.

• Vertical sync—VSYNC is the synchronization pulse generated at 

the beginning of each video field that signals the video monitor 

when to start a new field.

• Pixel clock—PCLK times the sampling of pixels on a video line.

• Composite sync—CSYNC is the signal consisting of combined 

horizontal sync pulses and vertical sync pulses.
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• Active pixel region—The active pixel region is the region of pixels 

actively being stored. The active pixel region is defined by a pixel 

start (relative to HSYNC) and a pixel count.

• Horizontal count—The horizontal count is the total number of 

pixels between two HSYNC signals. The horizontal count 

determines the frequency of the pixel clock.

• Active line region—The active line region is the region of lines 

actively being stored. The active line region is defined by a line 

start (relative to VSYNC) and a line count.

• Line count—The line count is the total number of horizontal lines 

in the picture.

• Video line—A video line consists of an HSYNC, back porch, active 

pixel region, and a front porch, as shown in Figure 3-2.

Figure 3-2.  Video Line

• Picture aspect ratio—The picture aspect ratio is the ratio of the 

active pixel region to the active line region. For standard video 

signals like RS-170 or CCIR, the full-size picture aspect ratio 

normally is 4/3 (1.33).

• Pixel aspect ratio—The pixel aspect ratio is the ratio between the 

physical horizontal size and the vertical size of the region covered 

by the pixel. An acquired pixel should optimally be square, thus the 

optimal value is 1.0, but typically it falls between 0.95 and 1.05, 

depending on camera quality.

Horizontal Sync Pixel Region

Back Porch Front Porch
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• Field—For an interlaced video signal, a field is half the number of 

horizontal lines needed to represent a frame, as shown in 

Figure 3-3. The first field of a frame contains all the odd-numbered 

lines. The second field contains all of the even-numbered lines.

Figure 3-3.  Video Field

• Frame—A frame is a complete image. In interlaced formats, a 

frame is composed of two fields.

Programming Video Parameters
You can program all of these video parameters on the PCI-1408:

• Programmable pixel and line count—When generating an internal 

PCLK, the PCI-1408 uses a programmable clock generator with an 

advanced VCO circuit. This circuitry generates a PCLK frequency 

from 11 to 16.5 MHz, depending on the horizontal count. The 

standard sampling rate for RS-170/NTSC video signals is 

12.3 MHz, and the standard sampling rate for CCIR/PAL is 

14.75 MHz. To correct for external pixel aspect ratio errors of up 

to ±9%, the VCO covers the range from approximately 11.0 to 

16.5 MHz.

The PCI-1408 also includes a programmable line count, which you 

use to switch between RS-170/NTSC (525 lines) and CCIR/PAL 

(625 lines). In addition, the PCI-1408 supports any line count up to 

1,024 lines for nonstandard video inputs.

Note: You can have up to 2,048 lines in interlaced mode by combining fields.
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• Acquisition window—After setting the pixel and line count, you 

must program the active pixel region and active line region. The 

active pixel region selects the starting pixel and number of pixels 

to be acquired relative to the HSYNC signal. The active line region 

selects the starting line and number of lines to be acquired relative 

to the VSYNC signal.

• Region of interest—The PCI-1408 uses a second level of active 

pixel and active line regions for selecting a region of interest. When 

you disable the region-of-interest circuitry, the board stores the 

entire acquisition window in system memory. However, when you 

enable the region-of-interest circuitry, the board transfers only a 

selected subset of the digitized frame to system memory. 

• Scaling down—The scaling-down circuitry also controls the active 

acquisition region. The PCI-1408 can scale down a frame by 

reducing pixel, lines, or both. For active pixel selection, the 

PCI-1408 can select every pixel, every other pixel, every fourth 

pixel, or every eighth pixel. For active line selection, the PCI-1408 

can select every line, every odd line, or multiples of odd lines, for 

example, every other odd line or every fourth odd line. You can use 

the scaling-down circuitry in conjunction with the region-of-

interest circuitry.

• Interlaced video—The PCI-1408 supports both interlaced and 

noninterlaced video signals. In interlaced mode, the PCI-1408 

combines the odd and even field into one contiguous frame for 

analysis. In noninterlaced mode, each field is treated as an 

independent frame.
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Acquisition Modes

The PCI-1408 supports three video acquisition modes:

• Standard mode—In standard mode, the PCI-1408 receives an 

incoming composite video signal from the external BNC or DSUB 

connector and generates CSYNC, HSYNC, VSYNC, and PCLK 

signals. The generated CSYNC signal is output on the DSUB 

connector for use by other image acquisition boards or to 

synchronize multiple cameras.

• CSYNC external mode—In CSYNC external mode, the PCI-1408 

receives an incoming video signal (composite or luminance) and an 

external CSYNC from an external connector. The PCI-1408 takes 

the incoming video signal and CSYNC and generates HSYNC, 

VSYNC, and PCLK signals.

• External lock mode—You can use this mode to synchronize to a 

camera or any nonstandard video signal. In this mode, the 

PCI-1408 receives HSYNC, VSYNC, and PCLK signals for A/D 

sampling directly from the external connector.
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Chapter

4Signal Connections

This chapter describes cable connections for the PCI-1408.

BNC Connector 

The BNC external connector supplies an immediate connection to the 

PCI-1408 VIDEO0 input. Use the 2 m BNC cable shipped with the 

PCI-1408 to connect a camera to VIDEO0. This connection cannot be 

used with VIDEO0 on the 25-pin DSUB I/O connector. You can 

configure the BNC connector only for RSE mode.

Note: Jumper W1 must be installed when using BNC input.

Figure 4-1.  BNC Connector Pin Assignment

I/O Connector

The 25-pin DSUB connector connects to all video signals (VIDEO0, 

VIDEO1, VIDEO2, and VIDEO3), the external digital I/O lines and 

triggers, and external signals. To access these connections, you can 

build your own custom cable or use one of the optional cables from 

National Instruments. Figure 4-2 shows the pinout of the 25-pin DSUB 

connector.

Note: Do not use the VIDEO0 connection on the 25-pin DSUB connector with the 

BNC connection.




GND

VIDEO0+
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Figure 4-2.  I/O Connector Pin Assignments

I/O Connector Signal Connection Descriptions
Table 4-1 describes each signal connection on the 25-pin DSUB 

connector.

Table 4-1.  I/O Connector Signals

Signal Name Description

VIDEO0± VIDEO0± allows for a DIFF or RSE connection to video channel 0. To operate in RSE 

mode, connect VIDEO0- to GND. When you use VIDEO0+ or VIDEO0-, you must 

disconnect the BNC connector.

VIDEO<3..1>± VIDEO<3..1>± allows for a DIFF or RSE connection to video channels 1, 2, and 3. 

To operate in RSE mode, connect VIDEO- to GND.

PCLKIN± Use PCLKIN± when the PCI-1408 is in external lock mode. In this mode, PCLKIN 

represents the A/D sampling clock. You can select PCLKIN to be TTL or RS-422 mode, 

depending on the jumper W3 configuration. In RS-422 mode, both PCLKIN+ and 

PCLKIN- receive the PCLK signal. The PCLKIN polarity is programmable.

HSYNCIN± Use HSYNCIN± when the PCI-1408 is in external lock mode. HSYNC is a 

synchronization pulse produced at the beginning of each video scan line that keeps a 

video monitor's horizontal scan rate in step with the transmission of each new line. You 

can set HSYNCIN in TTL or RS-422 mode depending on jumper W3 configuration. In 

RS-422 mode, both HSYNCIN+ and HSYNCIN- receive the HSYNC signal. The 

HSYNCIN polarity is programmable.

TRIG(0)

TRIG(2)

TRIG(3)

PCLKIN-/Unused

HSYNCIN-/Unused

VSYNCIN-/Unused

CSYNCIN-/Unused
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VSYNCIN± Use VSYNCIN± when the PCI-1408 is in external lock mode. VSYNC is a 

synchronization pulse generated at the beginning of each video frame that tells the video 

monitor when to start a new field. You can set VSYNCIN in TTL or RS-422 mode 

depending on jumper W3 configuration. In RS-422 mode, both VSYNCIN+ and 

VSYNCIN- receive the VSYNC signal. The VSYNCIN polarity is programmable.

CSYNCIN± Use CSYNCIN± when the PCI-1408 is in CSYNC external mode. CSYNC is a signal 

consisting of horizontal sync pulses, vertical sync pulses, and equalizing pulses only. You 

can set CSYNCIN in TTL or RS-422 mode, depending on jumper W3 configuration. In 

RS-422 mode, both CSYNCIN+ and CSYNCIN- receive the CSYNC signal. The 

CSYNCIN polarity is programmable.

CSYNCOUT CSYNCOUT is a TTL output of the internal CSYNC signal. In CSYNC external mode, 

CSYNCOUT maps directly to CSYNCIN. In standard mode, the synchronization 

circuitry of the PCI-1408 generates CSYNCOUT.

TRIG<3..0> Triggers <3..0> are TTL I/O lines used to start or stop an acquisition or output an 

acquisition status. You can program the triggers to be rising- or falling-edge sensitive. 

You can also program the triggers to be programmatically asserted or unasserted similar 

in function to a digital I/O line. You can program TRIG<3..0> to reflect the following 

status bits:

Status Bit Description

AQ_IN_PROGRESS Signals an acquisition in progress

AQ_DONE Signals an acquisition is completed

HSYNC The appropriate HSYNC signal

PCLK The A/D sampling signal

GND GND is a direct connection to digital GND on the PCI-1408.

+5V +5V is a fused connection to +5 V on the PCI-1408 that allows a user to power external 

triggering circuitry with up to 100 mA.

Table 4-1.  I/O Connector Signals (Continued)

Signal Name Description
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Chapter

5Configuration Utility

This chapter describes the basic functions of IMAQconf, the 

configuration and diagnostic utility included with the PCI-1408.

Introduction

IMAQconf performs the following functions:

• Configures the video parameters, which are automatically loaded 

when the saved interface is loaded in NI-IMAQ.

• Displays a histograph, which acts as an aid to configuring your 

board.

• Displays various look-up tables that let you implement small image 

processing functions in the hardware.

• Performs snap and continuous video acquisition for diagnostics and 

verification.

• Creates new camera files for non-standard cameras.

• Saves acquired images to a bmp format.

Using IMAQconf

To configure your IMAQ board, make sure the board is properly 

installed (see Chapter 2, Configuration and Installation) and then run 

the IMAQconf configuration utility. IMAQconf is located under the 

Windows 95 Start menu:

Start»Program»NI-IMAQ»IMAQconf

The following is a description of each of the tabs in the utility.
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Description Tab
The Description tab in the IMAQconf configuration utility is where 

basic information about your IMAQ board is stored, such as the 

interface name, board type, base address, and interrupt the board uses. 

Figure 5-1 shows the information included in this tab. IMAQconf 

automatically fills in this information.

Figure 5-1.  Description Tab

Save Interface
Button

Snap Function
Button

Grab Function
Button

Histogram Function
Button

Available Interfaces

Diagnostic Function
Button

Interface Name

Type of Board
Found

Base Address
of Board

IRQ of Board

List of Serial Numbers
of Installed Boards



Chapter 5 Configuration Utility

© National Instruments Corporation 5-3 PCI-1408/NI-IMAQ for Win95/NT

Camera Tab
The Camera tab stores a list of available cameras and camera settings. 

You can modify existing camera settings or create a new camera file by 

saving the existing camera file via the File»Save As... menu selection. 

Figure 5-2 shows each item included in this tab.

Figure 5-2.  Camera Tab

You use IMAQconf to configure each active video channel. You can 

configure only one video channel at a time. You can access VIDEO0 

through the BNC connector or the 25-pin DSUB connector. You can 

access all other video signals only via the 25-pin DSUB connector.
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Basic Camera Settings
The Camera tab is also for configuring your cameras. Figure 5-3 shows 

the Basic button popup screen.

Figure 5-3.  Basic Camera Settings

Basic settings include:

• Camera Description—You can enter a description of up to 64 

characters for this camera.

• Mode—You can place the PCI-1408 in frame or field mode. Use 

frame mode with interlaced video signals. In frame mode, the 

PCI-1408 waits for a programmable (odd or even) field before 

starting a video acquisition. In addition, the PCI-1408 combines the 

odd and even fields into one video frame in system memory for 

analysis.

Use field mode with either interlaced or noninterlaced video 

signals. In field mode, the PCI-1408 acquires any video field and 

transfers it to PCI system memory.
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• Chroma Filter—The PCI-1408 includes optional antichrominance 

filters to use with NTSC and PAL video signals. The three options for 

the color filters are as follows:

– None—The antichrominance filter is disabled.

– NTSC—The antichrominance filter is enabled for 

NTSC-coded signals. The filtering is implemented by a 

3.58 MHz notch filter.

– PAL—The antichrominance filter is enabled for PAL-coded 

signals. The filtering is implemented by a 4.43 MHz notch 

filter.

• Acquisition Window—The acquisition window determines the 

window offset and window size of the start of the video frame as well 

as the number of active horizontal pixels and active lines. 

• Gain—The PCI-1408 has three programmable gain values: 1, 1.33, 

and 2, which correspond to a fine adjustment of the black and white 

reference levels of 20, 15, and 10 mV steps. Monitor the displayed 

histograph to choose the appropriate gain level.

• Interlace—This specifies whether the camera is interlaced or non-

interlaced.

• Reference Level—This setting optimizes the input signal range and 

includes two components:

– White—The PCI-1408 uses a programmable white reference 

level to optimize the input signal range. Monitor the displayed 

histograph to choose the appropriate white offset level. With a 

gain of 1, the white reference level is programmable in the 

range of 0 to 1.28 V in 64 steps of 20 mV each.

– Black—The PCI-1408 uses a programmable black reference 

level to optimize the input signal range. Monitor the displayed 

histograph to choose the appropriate black offset level. With a 

gain of 1, the black reference level is programmable in the 

range of 0 to 1.28 V in 64 steps of 20 mV each.

• Auto Expos.—Pressing this button tells IMAQconf to perform a single 

acquisition and then calculate the optimum gain and white and black 

reference levels.
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Advanced Camera Settings
The Advanced camera settings button lets you fine-tune the 

configuration for your specific camera.

Figure 5-4 shows the advanced camera settings popup screen.

Figure 5-4.  Advanced Camera Settings

Advanced camera settings include:

• HSYNC Start and HSYNC Stop—These settings define the 

positioning and duration of the internally generated horizontal 

(line) synchronization pulse. To generate a negative edge at 

position zero, set the HSYNC Stop value to 0. The width of the 

pulse in samples is defined by the difference in pixels between 

HSYNC Start and HSYNC Stop and is typically 4.7 µs for 

standard video.
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• CLAMP Start and CLAMP Stop—The clamp signal restores the 

DC level to the AC-coupled video signal. The clamping pulse must 

be positive (CLAMP Stop > CLAMP Start) and must be applied 

on each line somewhere during the blanking period of the video 

signal, typically between the end of the color burst and the 

beginning of the active video line for a color camera or anytime on 

the back porch period of the video signal for a monochrome 

camera. The duration of the pulse (CLAMP Stop – CLAMP Start) 

should be as long as possible and greater than five samples.

• ZERO Start and ZERO Stop—The zero signal calibrates the ADC 

on each video line. The pulse conditions—positioning and 

duration—are the same as for the clamping pulse.

• NGate Start and NGate Stop—The noise gate (NGate) settings 

define the period of a video line after lock to a video source where 

the genlock circuitry will not detect a HSYNC pulse. This 

nondetection period is used to avoid false HSYNC detection due to 

noise in the video signal or equalization pulses during the vertical 

synchronization period. For a typical video signal, the noise gate 

signal starts after HSYNC Stop and stops approximately 3% before 

the end of the video line defined by HCOUNT.

• FIELD Start and FIELD Stop—The field gate signal defines the 

portion of the video line during vertical synchronization where the 

field conditions are detected. The duration of the field gate pulse 

must be approximately 50% of the duration of the line defined by 

HCOUNT and the positioning should be approximately 25% of the 

line. By swapping the values of FIELD Start and FIELD Stop, 

you can reverse the order of the acquired fields (even/odd or 

odd/even).

• HCOUNT—This setting defines the total number of pixels that can 

be acquired for the entire video line, including synchronization and 

blanking signals. For example, the total duration of a video line is 

64 µs for a CCIR signal, but the duration of the active video line 

containing image information is only 52 µs. To acquire a picture 

with 768 pixels, enter the value of 768 * 64/52, rounded to 945, into 

HCOUNT. Changing the value of HCOUNT affects the pixel 

aspect ration of the picture. (See Aspect Ratio Correction later in 

this section.)

• VSYNC—The VSYNC register defines the duration of the 

internally generated vertical synchronization pulse. For standard 

video, the value of HCOUNT/8 is recommended. 
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• Sync Detect—This register defines the comparator voltage used to 

detect a horizontal synchronization pulse. The reference level is the 

voltage of the sync tips. For a typical video signal, the sync tips is 

approximately 300 mV below the blanking level and the highest 

detection value of 125 mV is recommended. Lower values may be 

used if the incoming video signal is weak or noisy.

• Aspect Ratio Correction—This function adjusts the pixel aspect 

ratio of the acquired picture and also compensates for pixel aspect 

ratio errors of the camera. Given a standard video format with a 

default configuration, you can correct errors up to ±8% in steps of 

1/HCOUNT or typically 0.15%. Note that using this function will 

affect most of the Advanced camera settings parameters. The 

function automatically will reposition and resize the picture by 

adjusting the region of interest offset and width parameters so that 

the visual region of interest stays unchanged. After you change the 

Aspect Ratio Correction and click the OK button, a warning 

message will appear that tells you the Acquisition Window width 

and X-offset under the Basic Camera dialog box have changed. If 

necessary, you can manually readjust the ROI parameter.
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LUT Tab

You can configure the input look-up table (LUT) to implement 

simple imaging operations such as contrast enhancement, data 

inversion, gamma manipulation, or other nonlinear transfer 

function. Figure 5-5 shows the LUT tab settings.

Figure 5-5.  LUT Tab Settings

You can control the LUT through the NI-IMAQ software or you 

can select a predefined LUT in the IMAQconf configuration utility.
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The predefined LUT selections are as follows:

• Normal—When you select this option, the LUT is effectively 

disabled, as shown in Figure 5-6.

Figure 5-6.  Normal LUT

• Inverse—When you select this option, the LUT inverts the 

gray levels, as shown in Figure 5-7.

Figure 5-7.  Inverse LUT
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• Log—When you select this option, the LUT converts the 

sampled data to a logarithmic form that produces greater 

contrast in the black region, as shown in Figure 5-8.

Figure 5-8.  Log LUT

• Exponential—When you select this option, the LUT converts 

the sampled data to a logarithmic form that produces greater 

contrast in the white region, as shown in Figure 5-9.

Figure 5-9.  Exponential LUT
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• Binary—When you select this option, the LUT converts the 

sampled data to a binary image of black or white, as shown in 

Figure 5-10. The threshold point is determined by the number 

you set in the Binary Threshold box.

Figure 5-10.  Binary LUT
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• Inverse Binary—When you select this option, the LUT 

converts the sampled data to a binary image of black or white 

with the lighter areas becoming black and the darker areas 

white, as shown in Figure 5-11. The threshold point is 

determined by the number you set in the Binary Threshold 

box.

Note: The Binary Threshold option specifies the threshold point for the binary 

and inverse binary LUTs. This option is disabled for the other LUTs.

Figure 5-11.  Inverse Binary LUT
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Operating Mode Tab
The Operating Mode tab contains settings for video synchronization 

signals. 

Figure 5-12 displays the Operating Mode tab.

Figure 5-12.  Operating Mode Tab

Operating Mode settings include:

• Slave Acquisition Mode—The PCI-1408 supports the following 

slave acquisition modes:

– Standard—In standard mode, the PCI-1408 receives an 

incoming video signal and generates a CSYNC signal. The 

internal CSYNC signal generates the PCLK, HSYNC, and 

VSYNC signals. The PCI-1408 acquisition control circuitry 

uses these signals to store the acquired data in PCI memory. 

You can control each of these signals in software. The board 

parameters adjust the pixels per line (to generate PCLK), the 
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horizontal start (to generate HSYNC), and the vertical start and 

lines (to generate VSYNC).

Note: The Signal Polarity and CSYNC Signal Source options are disabled in this 

mode.

– CSYNC External Mode—In CSYNC external mode, the 

PCI-1408 receives an incoming CSYNC to generate the PCLK, 

HSYNC, and VSYNC signals. The PCI-1408 acquisition 

control circuitry uses these signals to store the acquired data in 

PCI memory. You can control each of these signals in 

software. The board parameters adjust pixels per line (to 

generate PCLK), horizontal start (to generate HSYNC), and 

vertical start and lines (to generate VSYNC). 

When you select CSYNC external mode, the CSYNC polarity 

field also becomes valid. You can configure CSYNC to be 

active high or active low (rising or falling edge sensitive).

Note: The Signal Polarity and CSYNC Signal Source options are active in this 

mode.

– External Lock Mode—In external lock mode, the PCI-1408 

receives PCLK, HSYNC, and VSYNC from the external 

connector. When you select external lock mode, the HSYNC 

polarity, VSYNC polarity, and PCLK polarity fields also 

become valid. You can configure each signal to be active high 

or active low (rising or falling edge sensitive).

Note: The Signal Polarity option is active and the CSYNC Signal Source option 

is disabled in this mode.

• Signal Polarity—You can control the signal polarity for the 

CSYNC, HSYNC, VSYNC, and PCLK signals. The default is True 

Low.

• Signal Source CSYNC—You can specify the input source for the 

CSYNC signal as either channel 0, channel 1, channel 2, channel 3, 

or external.
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Saving Your Configuration

When you complete the configuration, choose the File»Save option to 

save the resulting configuration so that the NI-IMAQ software can 

reference it.

Testing Your Configuration

After setup, use IMAQconf to test your configuration using its Grab and 

Snap functions, located either in the utility toolbar or under the Acquire 

menu (see Figure 5-1). You can use the resulting image and histograph 

to modify your configuration.

The functions for testing your configuration are as follows:

• Grab—Click the Grab button to make the PCI-1408 capture 

images in continuous mode at the maximum rate. If your display 

cannot keep up with the maximum rate acquisition, IMAQconf will 

continue to acquire images at the maximum rate but will display the 

images onscreen at the fastest allowable rate your system supports. 

The acquisition and display rates are shown in the title bar. Pressing 

the Grab button for the second time halts the grab function and 

displays the last acquired image on the screen.

• Snap—Clicking the Snap button will result in the PCI-1408 

capturing and displaying a single video frame or field depending on 

the mode of the board. 

• Histograph—The PCI-1408 displays the histograph of the captured 

image. You can use the histograph as an aid in setting the gain and 

offset values to receive the maximum input signal range.

• Diagnostics—The Diagnostics button lets you run diagnostic tests 

on the board. Pressing this button brings up the popup box shown 

in Figure 5-13.



Chapter 5 Configuration Utility

© National Instruments Corporation 5-17 PCI-1408/NI-IMAQ for Win95/NT

Figure 5-13.  Diagnostics Settings

Select the tests you want to perform. Click the Start button to start the 

diagnostics. The diagnostics will run each test that has been specified 

by the appropriate checkbox. These tests will be executed the number 

of times specified in the Iterations box. To stop the diagnostics, press 

the Stop button. The Completed box the number of test iterations 

performed.

Note: The Start button becomes a Stop button when you run the diagnostics.

Image Storage

The PCI-1408 can store the captured image in bitmap (bmp) format if 

you select File»Save from the pull-down menu or right-click in the 

video window and select File»Save.

Storing the image serves two purposes. First, it saves a reference 

picture. Second, you can use the PCI-1408 to acquire images that you 

can later modify with virtually any image processing application 

without using NI-IMAQ.
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Appendix

ASpecifications

This appendix lists the specifications of the PCI-1408. These 

specifications are typical at 25° C, unless otherwise stated.

Formats Supported

RS-170/NTSC.....................................60 Hz

(Interlaced mode: 60 fields/s)

CCIR/PAL ..........................................50 Hz

(Interlaced mode: 50 fields/s)

Variable scan ......................................Programmable

Video Input

Quantity ..............................................Four monochrome

Input impedance .................................75 Ω

VIDEO0..............................................RSE or DIFF (BNC or DSUB)

VIDEO<3..1> .....................................RSE or DIFF (DSUB)

Frequency response.............................20 MHz (-3 dB) typ

Antichrominance filter ........................Programmable (disabled,

3.58 MHz notch filter, or

4.43 MHz notch filter)

Filter characteristics............................Attenuation at notch frequency 

> 25 dB

Gain ....................................................Programmable

(1, 1.33, or 2)
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Black reference .................................. Programmable

(0–1.28 V in 64 20 mV steps

at a gain of 1)

White reference .................................. Programmable

(0–1.28 V in 64 20 mV steps

at a gain of 1)

A/D Conversion

Gray levels ......................................... 256 (8 bit)

Differential nonlinearity ..................... ±1 LSB max

RMS noise ......................................... < 0.5 LSB rms

Signal-to-noise ratio ........................... 48 dB typ

Sampling rate ..................................... 3 to 20 MHz,

externally clocked

Pixel aspect ratio ................................ Programmable

(VCO range 11.0 to 16.4 MHz)

External Connections

Trigger sense...................................... TTL

Trigger level ...................................... Programmable (rising or falling)

PCLKIN sense.................................... Selectable (TTL or RS-422)

PCLKIN level .................................... Programmable (direct or invert)

HSYNCIN sense ................................ Selectable (TTL or RS-422)

HSYNCIN level ................................. Programmable (rising or falling)

VSYNCIN sense ................................ Selectable (TTL or RS-422)

VSYNCIN level ................................. Programmable (rising or falling)

CSYNCIN sense................................. Selectable (TTL or RS-422)

CSYNCIN level ................................. Programmable (rising or falling)
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Pulse width .........................................50 ns

VIH (TTL) ...........................................2 V

VIL (TTL) ...........................................0.8 V

Internal Pixel Clock

Generate frequency .............................11.0 to 16.4 MHz

Pixel ratio for

standard video sources ........................±8%

Pixel jitter ...........................................< 5 ns peak

PCI Interface

PCI initiator (master) capability ..........Supported

PCI target (slave) capability................Supported

Data path ............................................32 bits

Card voltage .......................................5 V only

Card type ............................................32-bit half-size card

Parity generation/checking,

error reporting.....................................Supported

Target decode speed............................Medium (1 clock)

Target fast back-to-back capability .....Supported

Resource locking ................................Supported as a master and slave

PCI interrupts .....................................Interrupts passed on 

INTA# signal

Base address registers .........................BAR0 (16 KB)

BAR1 (64 KB)
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Expansion ROM................................. 4 KB

PCI master performance

 Ideal ........................................... 133 Mbytes/s

 Sustained .................................... 100 Mbytes/s

Power Requirements

Voltage .............................................. +5 V (1.34 A)

+12 V (100 mA)

-12 V (50 mA)

Physical

Dimensions ........................................ 10.668 by 17.463 cm

(4.2 by 6.875 in.)

Weight ............................................... 0.127 kg (0.028 lb.)

Environment

Operating temperature ........................  0–50° C

Storage temperature ........................... -20–70° C
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Appendix

BCustom Cables

This appendix lists specifications for building custom cables for your 

PCI-1408.

Cable Specification

National Instruments offers cables and accessories for you to connect to 

video sources, trigger sources, or synchronization sources. However, if 

you want to develop your own cables, the following guidelines must be 

met:

• For the video inputs, use a 75 Ω shielded coaxial cable.

• For the digital triggers and synchronization signals, twisted pairs 

for each signal yield the best result.

• For the 25-pin DSUB connector, use AMP part number 747912-2 

or equivalent.

For information on connector pin assignments, see the I/O Connector 

section in Chapter 4, Signal Connections.

Connector specifications include:

•     Video and sync signals 75 Ω impedance

•     Trigger signals TTL

•     Type 75 Ω BNC or

25-pin DSUB receptacle

(as shown in Figure B-1)

Figure B-1.  25-Pin DSUB Receptacle

1

1425

13
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Appendix

CCustomer Communication

For your convenience, this appendix contains forms to help you gather the information necessary 

to help us solve your technical problems and a form you can use to comment on the product 

documentation. When you contact us, we need the information on the Technical Support Form and 

the configuration form, if your manual contains one, about your system configuration to answer 

your questions as quickly as possible.

National Instruments has technical assistance through electronic, fax, and telephone systems to 

quickly provide the information you need. Our electronic services include a bulletin board service, 

an FTP site, a FaxBack system, and e-mail support. If you have a hardware or software problem, 

first try the electronic support systems. If the information available on these systems does not 

answer your questions, we offer fax and telephone support through our technical support centers, 

which are staffed by applications engineers. 

Electronic Services

National Instruments has BBS and FTP sites dedicated for 24-hour support with a collection of 

files and documents to answer most common customer questions. From these sites, you can also 

download the latest instrument drivers, updates, and example programs. For recorded instructions 

on how to use the bulletin board and FTP services and for BBS automated information, call 

(512) 795-6990. You can access these services at:

United States: (512) 794-5422 or (800) 327-3077

Up to 14,400 baud, 8 data bits, 1 stop bit, no parity

United Kingdom: 01635  551422

Up to 9,600 baud, 8 data bits, 1 stop bit, no parity

France: 1 48 65 15 59

Up to 9,600 baud, 8 data bits, 1 stop bit, no parity

To access our FTP site, log on to our Internet host, ftp.natinst.com, as anonymous and use 

your Internet address, such as joesmith@anywhere.com, as your password. The support files 

and documents are located in the /support directories.

Bulletin Board Support

FTP Support



FaxBack is a 24-hour information retrieval system containing a library of documents on a wide 

range of technical information. You can access FaxBack from a touch-tone telephone at 

(512) 418-1111.

You can submit technical support questions to the appropriate applications engineering team 

through e-mail at the Internet addresses listed below.  Remember to include your name, address, 

and phone number so we can contact you with solutions and suggestions. 

DAQ:  daq.support@natinst.com LabWindows:  lw.support@natinst.com
GPIB:  gpib.support@natinst.com Lookout:  lookout.support@natinst.com
HiQ:  hiq.support@natinst.com VISA:  visa.support@natinst.com
LabVIEW:  lv.support@natinst.com VXI:  vxi.support@natinst.com

Fax and Telephone Support
National Instruments has branch offices all over the world.  Use the list below to find the technical 

support number for your country.  If there is no National Instruments office in your country, 

contact the source from which you purchased your software to obtain support.

Telephone  Fax

Australia 03 9879 5166 03 9879 6277

Austria 0662 45 79 90 0 0662 45 79 90 19

Belgium 02 757 00 20 02 757 03 11

Canada (Ontario) 905 785 0085 905 785 0086

Canada (Quebec) 514 694 8521 514 694 4399

Denmark 45 76 26 00 45 76 26 02

Finland 90 527 2321 90 502 2930

France 01 48 14 24 24 01 48 14 24 14

Germany 089 741 31 30 089 714 60 35

Hong Kong 2645 3186 2686 8505

Israel 03 5734815 03 5734816

Italy 02 413091 02 41309215

Japan 03 5472 2970 03 5472 2977

Korea 02 596 7456 02 596 7455

Mexico 95 800 010 0793 5 520 3282

Netherlands 0348 433466 0348 430673

Norway 32 84 84 00 32 84 86 00

Singapore 2265886 2265887

Spain 91 640 0085 91 640 0533

Sweden  08 730 49 70 08 730 43 70

Switzerland 056 200 51 51 056 200 51 55

Taiwan 02 377 1200 02 737 4644

U.K. 01635 523545 01635 523154

FaxBack Support

E-Mail Support (currently U.S. only)



Technical Support Form
Photocopy this form and update it each time you make changes to your software or hardware, and 

use the completed copy of this form as a reference for your current configuration. Completing this 

form accurately before contacting National Instruments for technical support helps our 

applications engineers answer your questions more efficiently.

If you are using any National Instruments hardware or software products related to this problem, 

include the configuration forms from their user manuals. Include additional pages if necessary.

Name __________________________________________________________________________

Company _______________________________________________________________________

Address ________________________________________________________________________

_______________________________________________________________________________

Fax (___ )___________________ Phone (___ ) ________________________________________

Computer brand ________________ Model ________________ Processor___________________

Operating system (include version number) ____________________________________________

Clock speed ______MHz   RAM _____MB  Display adapter __________________________

Mouse ___yes   ___no     Other adapters installed _______________________________________

Hard disk capacity _____MB Brand _____________________________________________

Instruments used _________________________________________________________________

_______________________________________________________________________________

National Instruments hardware product model __________  Revision ______________________

Configuration ___________________________________________________________________

National Instruments software product ____________________________ Version ____________

Configuration ___________________________________________________________________

The problem is: __________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

List any error messages: ___________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

The following steps reproduce the problem:____________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________



PCI-1408 Hardware and Software Configuration Form
Record the settings and revisions of your hardware and software on the line to the right of each 

item. Complete a new copy of this form each time you revise your software or hardware 

configuration, and use this form as a reference for your current configuration. Completing this 

form accurately before contacting National Instruments for technical support helps our 

applications engineers answer your questions more efficiently.

National Instruments Products

IMAQ hardware __________________________________________________________________

Interrupt level of hardware __________________________________________________________

DMA channels of hardware _________________________________________________________

Base I/O address of hardware ________________________________________________________

Programming choice _______________________________________________________________

NI-IMAQ, IMAQ Vision, LabVIEW, or LabWindows/CVI version _________________________

Other boards in system _____________________________________________________________

Base I/O address of other boards _____________________________________________________

DMA channels of other boards ______________________________________________________

Interrupt level of other boards _______________________________________________________

Other Products

Computer make and model _________________________________________________________

Microprocessor ___________________________________________________________________

Clock frequency or speed ___________________________________________________________

PCI chipset ______________________________________________________________________

Type of video board installed ________________________________________________________

Operating system version ___________________________________________________________

Operating system mode ____________________________________________________________

Programming language ____________________________________________________________

Programming language version ______________________________________________________

Other boards in system _____________________________________________________________

Base I/O address of other boards _____________________________________________________

DMA channels of other boards ______________________________________________________

Interrupt level of other boards _______________________________________________________



Documentation Comment Form
National Instruments encourages you to comment on the documentation supplied with our 

products. This information helps us provide quality products to meet your needs.

Title: Getting Started with Your IMAQ PCI-1408 and the NI-IMAQ Software for

Windows 95/NT

Edition Date: November 1996

Part Number: 321325A-01

Please comment on the completeness, clarity, and organization of the manual.

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

If you find errors in the manual, please record the page numbers and describe the errors.

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

Thank you for your help.

Name _________________________________________________________________________

Title __________________________________________________________________________

Company _______________________________________________________________________

Address ________________________________________________________________________

_______________________________________________________________________________

Phone (___ )__________________________  Fax (___ ) _________________________________

Mail to: Technical Publications Fax to: Technical Publications

National Instruments Corporation National Instruments Corporation

6504 Bridge Point Parkway (512) 794-5678

Austin, TX  78730-5039



© National Instruments Corporation G-1 PCI-1408/NI-IMAQ for Win95/NT

Glossary

Numbers/Symbols

% percent

+ positive of, or plus

+5V 5 V signal

- negative of, or minus

/ per

± plus or minus

Ω ohm

Prefix Meaning Value

p- pico- 10-12

n- nano- 10-9

µ- micro- 10-6

m- milli- 10-3

k- kilo- 103

M- mega- 106

G- giga- 109
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A

A amperes

AC alternating current

acquisition window the image size specific to a video standard or camera resolution

active line region the region of lines actively being stored; defined by a line start 

(relative to VSYNC) and a line count

active pixel region the region of pixels actively being stored; defined by a pixel start 

(relative to HSYNC) and a pixel count

A/D analog-to-digital

ADC analog-to-digital converter—an electronic device, often an 

integrated circuit, that converts an analog voltage to a digital 

number

address character code that identifies a specific location (or series of 

locations) in memory

ANSI American National Standards Institute

antichrominance filter removes the color information from the video signal

API application programming interface

AQ_DONE signals that the acquisition of a frame or field is completed

AQ_IN_PROGRESS signals that the acquisition of video data is in progress

area a rectangular portion of an acquisition window or frame that is 

controlled and defined by software

array ordered, indexed set of data elements of the same type

ASIC Application-Specific Integrated Circuit—a proprietary 

semiconductor component designed and manufactured to perform 

a set of specific functions for a specific customer

aspect ratio the ratio of a signal’s width to its height
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B

b bit—one binary digit, either 0 or 1

B byte—eight related bits of data, an eight-bit binary number; also 

used to denote the amount of memory required to store one byte 

of data

back porch the area of the video signal between the rising edge of the 

horizontal sync signal and the active video information

black reference level the level that represents the darkest an image can get

See also white reference level.

buffer temporary storage for acquired data

bus the group of conductors that interconnect individual circuitry in a 

computer, such as the PCI bus; typically the expansion vehicle to 

which I/O or other devices are connected

C

C Celsius

cache high-speed processor memory that buffers commonly used 

instructions or data to increase processing throughput

CCIR Comite Consultatif International des Radiocommunications—a 

committee that developed standards for color video signals

chrominance the color information in a video signal

CMOS complementary metal-oxide semiconductor

compiler a software utility that converts a source program in a high-level 

programming language, such as Basic, C or Pascal, into an object 

or compiled program in machine language. Compiled programs 

run 10 to 1,000 times faster than interpreted programs

See also Interpreter.
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conversion device device that transforms a signal from one form to another; for 

example, analog-to-digital converters (ADCs) for analog input 

and digital-to-analog converters (DACs) for analog output

CPU central processing unit

CSYNC composite sync signal; a combination of the horizontal and 

vertical sync pulses

CSYNCIN composite sync in signal

CSYNCOUT composite sync out signal

D

D/A digital-to-analog

DAC digital-to-analog converter; an electronic device, often an 

integrated circuit, that converts a digital number into a 

corresponding analog voltage or current

DAQ data acquisition—(1) collecting and measuring electrical signals 

from sensors, transducers, and test probes or fixtures and 

inputting them to a computer for processing; (2) collecting and 

measuring the same kinds of electrical signals with A/D or DIO 

boards plugged into a computer, and possibly generating control 

signals with D/A and/or DIO boards in the same computer

dB decibel; the unit for expressing a logarithmic measure of the ratio 

of two signal levels: dB=20log10 V1/V2, for signals in volts

DC direct current

default setting a default parameter value recorded in the driver; in many cases, 

the default input of a control is a certain value (often 0) that means 

use the current default setting.

DIN Deutsche Industrie Norme

DLL dynamic link library—a software module in Microsoft Windows 

containing executable code and data that can be called or used by 

Windows applications or other DLLs; functions and data in a DLL 

are loaded and linked at run time when they are referenced by a 

Windows application or other DLLs
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DMA direct memory access—a method by which data can be transferred 

to and from computer memory from and to a device or memory on 

the bus while the processor does something else; DMA is the 

fastest method of transferring data to/from computer memory

DRAM dynamic RAM

drivers software that controls a specific hardware device such as an 

IMAQ or DAQ device.

dynamic range the ratio of the largest signal level a circuit can handle to the 

smallest signal level it can handle (usually taken to be the noise 

level), normally expressed in dB

E

EEPROM electrically erasable programmable read-only memory—ROM 

that can be erased with an electrical signal and reprogrammed

external trigger a voltage pulse from an external source that triggers an event such 

as A/D conversion

F

field For an interlaced video signal, a field is half the number of 

horizontal lines needed to represent a frame of video; the first 

field of a frame contains all the odd-numbered lines, the second 

field contains all of the even-numbered lines.

FIFO first-in first-out memory buffer—the first data stored is the first 

data sent to the acceptor; FIFOs are used on IMAQ devices to 

temporarily store incoming data until that data can be retrieved. 

For example, an analog input FIFO stores the results of A/D 

conversions until the data can be retrieved into system memory, a 

process that requires the servicing of interrupts and often the 

programming of the DMA controller. This process can take 

several milliseconds in some cases. During this time, data 

accumulates in the FIFO for future retrieval. 

flash ADC an ADC whose output code is determined in a single step by a 

bank of comparators and encoding logic
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frame a complete image; in interlaced formats, a frame is composed of 

two fields

front porch the area of a video signal between the start of the horizontal blank 

and the start of the horizontal sync

ft feet

function a set of software instructions executed by a single line of code that 

may have input and/or output parameters and returns a value when 

executed; examples of functions are:

y = COS (x)

status = AO_config(board, channel, range)

G

gamma the nonlinear change in the difference between the video signal’s 

brightness level and the voltage level needed to produce that 

brightness

genlock circuitry that aligns the video timing signals by locking together 

the horizontal, vertical, and color subcarrier frequencies and 

phases and generates a pixel clock to clock pixel data into 

memory for display or into another circuit for processing

GND ground signal

GUI graphical user interface—an intuitive, easy-to-use means of 

communicating information to and from a computer program by 

means of graphical screen displays; GUIs can resemble the front 

panels of instruments or other objects associated with a computer 

program.

H

h hour

hardware the physical components of a computer system, such as the circuit 

boards, plug-in boards, chassis, enclosures, peripherals, cables, 

and so on
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HSYNC horizontal sync signal—the synchronization pulse signal 

produced at the beginning of each video scan line that keeps a 

video monitor's horizontal scan rate in step with the transmission 

of each new line

HSYNCIN horizontal sync input signal

Hz hertz—the number of scans read or updates written per second

I

IC integrated circuit

ID identification

IEEE Institute of Electrical and Electronics Engineers

IMAQconf a configuration and diagnostic utility included with IMAQ 

devices

in. inches

INL integral nonlinearity—A measure in LSB of the worst-case 

deviation from the ideal A/D or D/A transfer characteristic of the 

analog I/O circuitry

interlaced a video frame composed of two interleaved fields; the number of 

lines in a field are half the number of lines in an interlaced frame

instrument driver a set of high-level software functions, such as NI-IMAQ, that 

controls specific plug-in computer boards; instrument drivers are 

available in several forms, ranging from a function callable from 

a programming language to a virtual instrument (VI) in LabVIEW

interpreter a software utility that executes source code from a high-level 

language such as Basic, C or Pascal, by reading one line at a time 

and executing the specified operation

See also compiler.

interrupt a computer signal indicating that the CPU should suspend its 

current task to service a designated activity

interrupt level the relative priority at which a device can interrupt
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I/O input/output—the transfer of data to/from a computer system 

involving communications channels, operator interface devices, 

and/or data acquisition and control interfaces

IRQ interrupt request

K

k kilo—the standard metric prefix for 1,000, or 103, used with units 

of measure such as volts, hertz, and meters

K kilo—the prefix for 1,024, or 210, used with B in quantifying data 

or computer memory

kbytes/s a unit for data transfer that means 1,000 or 103 bytes/s

Kword 1,024 words of memory

L

library a file containing compiled object modules, each comprised of one 

of more functions, that can be linked to other object modules that 

make use of these functions.

line count the total number of horizontal lines in the picture

LSB least significant bit

LUT look-up table—a selection in the IMAQconf configuration utility 

that contains formulas that let you implement simple imaging 

operations such as contrast enhancement, data inversion, gamma 

manipulation, or other nonlinear transfer functions

M

m meters

M (1) Mega, the standard metric prefix for 1 million or 106, when 

used with units of measure such as volts and hertz; (2) mega, the 

prefix for 1,048,576, or 220, when used with B to quantify data or 

computer memory
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MB megabytes of memory 

Mbytes/s a unit for data transfer that means 1 million or 106 bytes/s

memory buffer See buffer. 

memory window continuous blocks of memory that can be accessed quickly by 

changing addresses on the local processor

MSB most significant bit

MTBF mean time between failure

mux multiplexer—a switching device with multiple inputs that 

selectively connects one of its inputs to its output

N

NI-IMAQ driver software for National Instruments IMAQ hardware

noninterlaced a video frame where all the lines are scanned sequentially, instead 

of divided into two frames as in an interlaced video frame

NTSC National Television Standards Committee—the committee that 

developed the color video standard used primarily in North 

America, which uses 525 lines per frame. See also PAL.

NVRAM nonvolatile RAM—RAM that is not erased when a device loses 

power or is turned off

O

operating system base-level software that controls a computer, runs programs, 

interacts with users, and communicates with installed hardware or 

peripheral devices

P

PAL Phase Alternation Line—one of the European video color 

standards; uses 625 lines per frame. See also NTSC.
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PCI Peripheral Component Interconnect—a high-performance 

expansion bus architecture originally developed by Intel to 

replace ISA and EISA; it is achieving widespread acceptance as a 

standard for PCs and workstations and offers a theoretical 

maximum transfer rate of 132 Mbytes/s

PCLK pixel clock signal—times the sampling of pixels on a video line

PCLKIN pixel clock in signal

PFI programmable function input

PGIA programmable gain instrumentation amplifier

picture aspect ratio the ratio of the active pixel region to the active line region; for 

standard video signals like RS-170 or CCIR, the full-size picture 

aspect ratio normally is 4/3 (1.33)

pixel picture element—the smallest division that makes up the video 

scan line; for display on a computer monitor, a pixel’s optimum 

dimension is square (aspect ratio of 1:1, or the width equal to the 

height)

pixel aspect ratio the ratio between the physical horizontal size and the vertical size 

of the region covered by the pixel; an acquired pixel should 

optimally be square, thus the optimal value is 1.0, but typically it 

falls between 0.95 and 1.05, depending on camera quality

pixel clock divides the incoming horizontal video line into pixels

pixel count the total number of pixels between two HYSNCs; the pixel count 

determines the frequency of the pixel clock

PLL phase-locked loop—circuitry that provides a very stable pixel 

clock that is referenced to another signal, for example, an 

incoming HSYNC signal

protocol the exact sequence of bits, characters, and control codes used to 

transfer data between computers and peripherals through a 

communications channel

pts points
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R

RAM random-access memory

real time a property of an event or system in which data is processed as it is 

acquired instead of being accumulated and processed at a later 

time

region-of-interest a hardware-programmable rectangular portion of the acquisition 

window

relative accuracy a measure in LSB of the accuracy of an ADC; it includes all 

nonlinearity and quantization errors but does not include offset 

and gain errors of the circuitry feeding the ADC

resolution the smallest signal increment that can be detected by a 

measurement system; resolution can be expressed in bits, in 

proportions, or in percent of full scale. For example, a system has 

12-bit resolution, one part in 4,096 resolution, and 0.0244 percent 

of full scale.

ribbon cable a flat cable in which the conductors are side by side

ROM read-only memory

RS-170 the U.S. standard used for black-and-white television

RTSIbus Real-Time System Integration Bus—the National Instruments 

timing bus that connects IMAQ and DAQ boards directly, by 

means of connectors on top of the boards, for precise 

synchronization of functions

S

s seconds

scaling down circuitry circuitry that scales down the resolution of a video signal

scatter-gather DMA a type of DMA that allows the DMA controller to reconfigure 

on-the-fly

SRAM static RAM
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sync tells the display where to put a video picture; the horizontal sync 

indicates the picture’s left-to-right placement and the vertical 

sync indicates top-to-bottom placement

syntax the set of rules to which statements must conform in a particular 

programming language

system RAM RAM installed on a personal computer and used by the operating 

system, as contrasted with onboard RAM

T

transfer rate the rate, measured in bytes/s, at which data is moved from source 

to destination after software initialization and set up operations; 

the maximum rate at which the hardware can operate

TRIG trigger signal

trigger any event that causes or starts some form of data capture

trigger control and circuitry that routes, monitors, and drives the external and

mapping circuitry RTSIbus trigger lines; you can configure each of these lines to 

start or stop acquisition on a rising or falling edge.

TTL transistor-transistor logic

V

V volts

VCO voltage-controlled oscillator—an oscillator that changes 

frequency depending on a control signal; used in a PLL to 

generate a stable pixel clock

VI Virtual Instrument—(1) a combination of hardware and/or 

software elements, typically used with a PC, that has the 

functionality of a classic stand-alone instrument (2) a LabVIEW 

software module (VI), which consists of a front panel user 

interface and a block diagram program

video line a video line consists of a HSYNC, back porch, active pixel region, 

and a front porch
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VSYNC vertical sync signal—the synchronization pulse generated at the 

beginning of each video field that tells the video monitor when to 

start a new field

VSYNCIN vertical sync in signal 

W

white reference level the level that defines what is white for a particular video system

See also black reference level.
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Index

Numbers
+5 V signal (table), 4-3

8-bit ADC and LUT, 3-3

A
acquisition and region of interest control, 3-4

acquisition modes

CSYNC external mode, 3-10, 5-15

external lock mode, 3-10, 5-15

standard, 3-10, 5-15

acquisition window. See also video acquisition.

parameters for controlling, 3-6 to 3-8

programming, 3-9

active line region, 3-7

active pixel region, 3-7

A/D conversion specifications, A-2

ADC, 8-bit, 3-3

antichrominance filter, 3-2

B
Binary option, LUT, 5-12

bitmap format, storing image as, 5-17

BNC connector, 4-1

board configuration. See configuration.

bulletin board support, C-1

C
cables

custom cable specifications, B-1

optional equipment, 1-5 to 1-6

Camera tab, IMAQconf utility, 5-3

advanced camera settings, 5-6 to 5-8

basic camera settings, 5-4 to 5-5

composite sync. See CSYNC signal.

configuration. See also installation.

external CLK and synchronization input 

mode, 2-3

parts locator diagram, 2-2

Switch S1, 2-4

VIDEO0 input mode, 2-2 to 2-3

configuration utility. See IMAQconf 

configuration utility.

CSYNC external mode

overview, 3-10

setting, 5-15

CSYNC multiplexer, 3-3

CSYNC signal

overview, 3-6

setting input mode, 2-3

signal source, 5-15

CSYNCIN± signal (table), 4-3

CSYNCOUT signal (table), 4-3

custom cable specifications, B-1

customer communication, xi, C-1 to C-2

D
delayed video acquisition, 3-6

Description tab, IMAQconf utility, 5-2

Diagnostics button, configuration testing, 5-16 

to 5-17

DIFF input configuration

external CLK and synchronization input 

mode, 2-3

VIDEO0 input mode, 2-2 to 2-3

DMA controllers, 3-5

documentation

conventions used in manual, x

National Instruments documentation, xi
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organization of manual, ix-x

related documentation, xi

E
electronic support services, C-1 to C-2

e-mail support, C-2

environment specifications, A-4

equipment, optional, 1-5 to 1-6

Exponential option, LUT, 5-11

external CLK and synchronization input 

mode, 2-3

external connection specifications, A-2 to A-3

external lock mode

overview, 3-10

setting, 5-15

F
fax and telephone support, C-2

FaxBack support, C-2

field, interlaced video signal, 3-8

FIFO buffer, 3-4

formats supported, A-1

frame, 3-8

frame/field selection, video acquisition, 3-6

FTP support, C-1

functional overview. See hardware overview.

G
genlock and synchronization circuitry, 3-3

GND signal (table), 4-2

Grab button, configuration testing, 5-16

H
hardware overview

functional overview, 3-1 to 3-5

8-bit ADC and LUT, 3-3

acquisition and region of interest 

control, 3-4

antichrominance filter, 3-2

board configuration NVRAM, 3-5

CSYNC mux, 3-3

FIFO buffer, 3-4

genlock and synchronization 

circuitry, 3-3

PCI interface, 3-5

PCI-1408 block diagram, 3-2

PCLK, HSYNC, VSYNC mux, 3-4

pixel aspect ratio circuitry, 3-3

programmable gain and offset, 3-2

RTSIbus, 3-4

scatter-gather DMA controllers, 3-5

SRAM, 3-5

trigger control and mapping 

circuitry, 3-4

VCO and PLL circuitry, 3-3

video mux, 3-2

video acquisition, 3-6 to 3-9

acquisition window control, 

3-6 to 3-8

programming video parameters, 

3-8 to 3-9

start/stop conditions, 3-6

video acquisition modes, 3-10

Histograph button, configuration testing, 5-16

horizontal count, 3-7

horizontal sync. See HSYNC signal.

HSYNC multiplexer, 3-4

HSYNC signal

overview, 3-6

setting input mode, 2-3

HSYNCIN± signal (table), 4-2

I
image storage, 5-17

IMAQ Vision for LabVIEW, 1-3

IMAQ Vision for LabWindows/CVI, 1-3

IMAQconf configuration utility, 5-1 to 5-17

Camera tab, 5-3

advanced camera settings, 5-6 to 5-8

basic camera settings, 5-4 to 5-5

Description tab, 5-2

LUT tab, 5-9 to 5-13
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Binary, 5-12

Disabled, 5-10

Exponential Log, 5-11

Inverse, 5-10

Inverse Binary, 5-13

Log, 5-11

Operating Mode tab, 5-14 to 5-15

CSYNC external mode, 5-15

external lock mode, 5-15

signal polarity, 5-15

signal source CSYNC, 5-15

Slave Acquisition Mode, 5-14 to 5-15

overview, 5-1

saving configuration file, 5-16

testing configuration, 5-16 to 5-17

Diagnostics, 5-16 to 5-17

Grab, 5-16

Histograph, 5-16

Snap, 5-16

installation. See also configuration.

procedure, 2-4 to 2-5

unpacking the PCI-1408, 1-6

interlaced video

interlaced vs. non-interlaced mode, 3-9

video field, 3-8

Inverse Binary, LUT, 5-13

Inverse option, LUT, 5-10

I/O connector, 4-1 to 4-2

pin assignments, 4-2

signal descriptions (table), 4-2 to 4-3

J
jumper and switch settings

external CLK and synchronization input 

mode, 2-3

Switch S1, 2-4

VIDEO0 input mode, 2-2 to 2-3

L
LabVIEW software, 1-3

LabWindows/CVI software, 1-3

line count

definition, 3-7

programmable, 3-8

Log option, LUT, 5-11

LUT (lookup table), 8-bit, 3-5

LUT (lookup table) tab, IMAQconf utility, 

5-9 to 5-13

Binary, 5-12

Normal, 5-10

Exponential, 5-11

Inverse, 5-10

Inverse Binary, 5-13

Log, 5-11

M
manual. See documentation.

N
NI-IMAQ driver software, 1-4 to 1-5

Normal option, LUT, 5-10

NVRAM, 3-3

O
Operating Mode tab, IMAQconf utility, 

5-14 to 5-15

CSYNC external mode, 5-15

external lock mode, 5-15

signal polarity, 5-15

signal source CSYNC, 5-15

Slave Acquisition Mode, 5-14 to 5-15

P
PCI interface

overview, 3-5

specifications, A-3 to A-4

PCI-1408

block diagram, 3-2

features, 1-1 to 1-2

optional equipment, 1-5 to 1-6

requirements, 1-2
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software programming choices, 1-3 to 1-5

National Instruments application 

software, 1-3

NI-IMAQ driver software, 1-4 to 1-5

unpacking, 1-6

PCI-1408 block diagram, 3-2

PCLK, HSYNC, VSYNC multiplexer, 3-4

PCLK signal

overview, 3-6

setting input mode, 2-3

specifications, A-3

PCLKIN± signal (table), 4-2

physical specifications, A-4

picture aspect ratio, 3-7

pixel and line count, programmable, 3-8

pixel aspect ratio, 3-7

pixel aspect ratio circuitry, 3-3

pixel clock. See PCLK signal.

PLL circuitry, 3-3

power requirement specifications, A-4

programmable gain and offset, 3-2

programming video parameters, 3-8 to 3-9

R
RAM

NVRAM, 3-5

SRAM, 3-5

Real-Time System Integration (RTSI) bus. See 

RTSIbus.

referenced single-ended (RSE) input 

configuration

external CLK and synchronization input 

mode, 2-3

VIDEO0 input mode, 2-2 to 2-3

region of interest circuitry

overview, 3-4

programming, 3-9

RTSIbus

features, 1-1 to 1-2

hardware overview, 3-4

S
S1 switch, setting, 2-4

saving configuration file, 5-16

scaling-down circuitry, 3-9

scatter-gather DMA controllers, 3-5

signal connections, 4-1 to 4-3

BNC connector, 4-1

I/O connector, 4-1 to 4-2

pin assignments, 4-2

signal descriptions (table), 4-2 to 4-3

signal polarity, 5-15

Snap button, configuration testing, 5-16

software control of video acquisition, 3-6

software programming choices, 1-3 to 1-5

IMAQ Vision for LabVIEW, 1-3

IMAQ Vision for LabWindows/CVI, 1-3

LabVIEW, 1-3

LabWindows/CVI, 1-3

NI-IMAQ driver software, 1-4 to 1-5

specifications

A/D conversion, A-2

environment, A-4

external connections, A-2 to A-3

formats supported, A-1

internal pixel clock, A-3

PCI interface, A-3 to A-4

physical, A-4

power requirements, A-4

video input, A-1 to A-2

SRAM, 3-5

standard mode

overview, 3-10

setting, 5-14

storing image in bitmap format, 5-17

switches. See jumper and switch settings.

synchronization circuitry, 3-3
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T
technical support, C-1 to C-2

testing configuration, 5-16 to 5-17

Diagnostics, 5-16 to 5-17

Grab, 5-16

Histograph, 5-16

Snap, 5-16

TRIG<3..0> signal (table), 4-3

trigger control and mapping circuitry, 3-4

trigger control of video acquisition, 3-6

V
VCO and PLL circuitry, 3-3

vertical sync. See VSYNC signal.

video acquisition, 3-6 to 3-9

programming video parameters, 

3-8 to 3-9

start/stop conditions, 3-6

video acquisition modes, 3-10

video field, interlaced video signal, 3-8

video input specifications, A-1 to A-2

video line, 3-7

video multiplexer, 3-2

video parameters, programming, 3-8 to 3-9

VIDEO0 input mode, configuring, 2-2 to 2-3

VIDEO0± signal (table), 4-2

VIDEO0<3..1>± signal (table), 4-2

VSYNC multiplexer, 3-4

VSYNC signal

overview, 3-6

setting input mode, 2-3

VSYNCIN± signal (table), 4-3
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